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Goodies list and Schedule: 

The above folks are responsible for bringing snacks and juice to the meeting. 
If you cannot bring goodies please call Sandy Watt 309-750-4351 and arrange a swap. 

03-07  J. & R. Fishback 
03-21  J. & R Hatfield 

01-03 J. Craig 
01-17 B. & S. Deming 

02-07  J. DeWeese 
02-21  J. Eklof 
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Page:  Content:     
                
3. Print night  - YTD 
4. Last Month Print night Judges Choice 
5.  Contd. 
6. EID night - YTD  
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8.  Contd. 
9.  Contd, 
10. Before and after 
11.  Contd. 
12. Field Trip Fun 
13.  Contd. 
14. Abe’s Book deals 
15. Judge’s Corner 
16. Cool Stuff 
17. Fun with PSA 
18.  Contd. 
19. Crossword 
20. Misc. & Board Minutes 

Cover  -  Tom Ambrose 

Club Officers: 
 President—John Craig jc_craig06@comcast.net  

Vice President—Frank Woodbery VANCWA@Comcast.net 
Secretary Treasurer—James Watt  tirnaog3@gmail.com 

Social Chair—Sandy Watt saendibruder@gmail.com 
Field Trip Chair—Rick Battson  Rbattson@comcast.net 

Web Co-Chair—B. Deming & D. Fischer rfdeming@comcast.net 
Touchmark Rep.:  Ray Klein  mklein@pacifier.com 

(Cntrl. Click to send email.) 
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Print Scores  -  Results YTD 

Year to date Mono. 
Mono Print Chair: Doug Fishcer 

cdfisc@comcast.net 

Year to date Color 
Color Print Chair:  Don Funderburg 

dfunde3280@yahoo.com 

Large Mono   

Cal Schuyler 64 

Don Funderburg 174 

Doug Fischer 175 

Grant Noel 41 

Jan Pelkey 90 

Katie Rupp 46 

Michael Anderson 43 

Sharp Todd 143 

Tali Funderburg 20 

Tim Morton 63 

Small Mono   

Bev Shearer 42 

Cal Schuyler 81 

Don Funderburg 173 

Grant Noel 44 

Jan Eklof 64 

Michael Anderson 44 

Sharp Todd 143 

MAKER LC SC Grand 
TTL 

Bev Shearer  85 85 

Calvin 
Schuyler 125 124 249 

Don 
Funderburg 174 172 346 

Doug Fischer 187  187 

Grant Noel 41 42 83 

Jan Eklof  179 179 

Jan Pelkey 129  129 

Katie Rupp 46 45 91 

Mark Shugert 44  44 

Michael 
Anderson 46 43 89 

Ray Klein 62  62 

Sharp Todd 146 144 290 

Stephen 
Cornick  60 60 

Tali 
Funderburg 21  21 

Tim Morton 181 131 312 

Wayne Hunter 90  90 

mailto:cdfisc@comcast.net
mailto:dfunde3280@yahoo.com
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Last Month Print Night  - Judges Choice 

SharpTodd_Grand Canyon 9-16 9_LM 

SharpTodd_Bryce Like A Castle Mono_LM 

JanEklof_BlueHourInPortland_SC 

SharpTodd_Bryce Features 10-16 3_LC 

SharpTodd_Grand Canyon Late Sun 1_LC 

SharpTodd_Mission San Jose Feature 4_LC 
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Last Month Print Night  - Judges Choice 

SharpTodd_Bryce Spires Mono 

SharpTodd_Mission Door Handle_SM 

SharpTodd_Mission Espada Mono_LM 

SharpTodd_Fancy Entrance_SC 

SharpTodd_River Walk Night 3_SC 

TimMorton_AutumnOrchard_LC 

WayneHunter_SodRoof_LC 
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EID Theme for January:  Night Shooting 

EID Scores  -  Results YTD 
EID chair: Frank Woodbery VANCWA@Comcast.net 

MAKER YTD MONO 
TOTALS 

YTD THEME 
TOTALS 

YTD OPEN 
TOTALS YTD TOTAL TOTALS 

Ambrose, Tom 23 23 45 91 
Anderson, Michael 23 0 42 65 
Battson, Rick 84 90 178 352 
Boos, Charles 61 42 130 233 
Boos, Ruth 0 41 133 174 
Campbell, Tammy 42 44 89 175 
Clark, George 90 87 182 362 
Cornick, Stephen 23 22 127 172 
Craig, John 82 92 188 362 
Deming, Bob 63 64 125 252 
Deming, Sharon 87 90 179 356 
Eklof, Jan 90 96 182 368 
Fischer, Doug 87 94 183 364 
Fishback, Jon 89 92 182 363 
Fishback, Rachel 63 36 106 205 
Forbes, Lan 0 0 21 21 
Forbes, Mark 45 21 87 153 
Funderburg, Don 82 89 173 344 
Funderburg, Tali 0 0 41 41 
Hunter, Wayne 0 0 44 44 
Johnson, John 0 21 42 63 
Klein, Ray 92 87 174 353 
LaBriere, David 87 85 178 350 
Moore, Lee 20 22 43 85 
Morton, Tim 65 47 134 246 
Noel, Grant 44 40 88 172 
Pelkey, Jan 90 87 179 356 
Rupp, Katie 87 66 187 340 
Schuyler, Cal 66 20 124 210 
Shugert, Mark 65 66 133 264 
Todd, Sharp 91 64 184 339 
Watt, James 43 43 85 171 
Watt, Sandy 82 84 170 336 
Woodbery, Frank 88 97 179 364 

It's not what you look at that matters, it's what you see. 
 Henry David Thoreau 

mailto:VANCWA@Comcast.net
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02DougFischer_FPCC_Tunnel_TH 

Last Month EID Night - Judges Choice 

04JanEklof_FPCC_TheRoadInTheWoods_TH 

05John-Craig_FPCC_SandhillCranes_O 

04JonFishback_FPCC_Fabric01_O 
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Last Month EID Night - Judges Choice 

01FrankWoodbery_FPCC_LimeKilnLighthouse#2_O 

01RayKlein_FPCC_OutForASpin_M 

01TimMorton_FPCC_MilkyWayAtOlallieLake_O 

02KatieRupp_FPCC_SomethingTastyAhead_O 

02RickBattson_FPCC_RoadArt_TH 

04MarkForbes_FPCC_SwiftCreekBC_O 
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Last Month EID Night - Judges Choice, contd. 

03DougFischer_FPCC_TetonsAtSunrise_O 

03georgeclark_FPCC_StJoes_O 

03JanEklof_FPCC_TheOldAndTheNew_M 

04DavidLaBriere_FPCC_RedwoodForestWhispers_O 

04FrankWoodbery_FPCC_RoadSpaghetti_TH 

05JohnCraig_FPCC_TheDallesMountainRanchRoad_TH 
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Before and After  -  Ray Klein 
Field Trip: RUST-O-RAMA 

 
EASILY USING LAYERS  
By Ray Klein, currently using Adobe Photoshop “Elements 
12” 
 
On a field trip to Salem, Oregon, on July 16, 2016, I followed 

through with gathering images of several of the cars., along 
with this Chevy. 
 
The following Monday I decided to take a drive east on 

Highway 14 to a Scenic Viewpoint, called Cape Horn, 
knowing there were quite a few winding roadways in that 
area.  With the Chevrolet image in mind, and still visible in my 
camera, I parked in the area of the pull off, and proceeded to 
make a few images, following the lines of the car, with the 
same focal length lens used for the car, of the road directly in 
line with the Cape Horn scenic viewpoint.  

 
  I made a copy of the automobile and saved the 
original.  Using the Polygonal selection tool, set at 
“0” pixels, I carefully selected the entire vehicle by 
clicking my way around it. Then with the vehicle 
completely selected, under the SELECT > 
“Inverse,” to select only the background, I was 
able to “EDIT” > “Delete” the entire 
background surrounding the vehicle. Now 
the  vehicle was in a pure white background and I 
could use the “Magic Wand” tool to again select 
the vehicle itself.  
   I made a copy of the road scene.  Bringing the 
image of the roadway, from “Cape Horn,” onto 
the “Elements 12” screen, I now had both images 
in view on the “Elements 12” screen.  Now again, 
going to the vehicle image I could click on the 
magic wand tool and use it to click on the all white 
area, and using “SELECT” > “inverse” select 
the car once again.  To get the car onto the road, 

click on the  “Move Tool” indicator and drag the image of 
the vehicle into the copy of the road scene.  As soon as the 
automobile is located over the road image, you have 
automatically created a layer.  You can now save and close 
out the previous individual car image.  Looking at the right 
hand thumbnail screen you can see both the car and the 
road scene thumbnails indicated.  Click your cursor on the 
car thumbnail image to work on the car, or click on the 
thumbnail road image to work on the road. The road is the 
base image and the car is layer 1.  You will be working with 
both in this process. 
 
 

Before 
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Click on the car thumbnail and the “Move Tool” to move the car into a position, using the arrow keys, up or down, right or left to 
move side to side, on the keyboard, to make it look like the car is sitting on the highway.  You will be working with both images to 
make the car appear to be actually in contact with the road. When the car looks like it is where it would belong, it is now time to create 
the shadow that will truly make it look like it is sitting on the highway. 
The Polygonal selection tool will now be used again, set at about 50 pixels or more depending on how soft or sharp you want your 

shadow to appear.  Now you will click on the road thumbnail because that is where you want the shadow to appear. Look at the 
original car image to see how the shadow appeared as it sat in the grass. You need to click on the road image under the car all the way 
around the bottom of the car and connect somewhere under and behind the car image. When the area of the shadow is to appear, is 
completed, select a gray tone with the “Eye Dropper Tool” from your color chart located under the  “Window” > Color Swatches 
column.  Usually a medium 50% gray tone will be satisfactory.  Now using the “Edit” > “Fill Selection,” the gray tone will appear on 
the road under the car.  If it is not satisfactory to your eye, then use “Edit” > to “un-fill” the selection, continue experimenting until 
the correct shadow is achieved. 
I noticed some partial grass was still seen where the tires touched the ground.  I had to use the tire image to clone away the grass so 

there no longer was any grass on the tires where they met the road.  
Now with the car and road joined together, and looking natural, I could work, using the “Enhance” column on the individual car or 

road to saturate the color and lighten or darken either the road or the car depending on which thumbnails I had selected.  Playing with 
the 2 images can consume quite a bit of time depending on how long it takes to satisfy the authenticity of the image. 
To make the car look like it was moving as if I had panned the camera with the car to blur the background, I used the “Filter” > 

“Blur - Radial Blur” to blur the background as if the car was moving.  
  Now that I felt the image was complete, I could use the final tools to make an image for competition. Looking at the screen with the 
final image I could now go to “Layer” > “Flatten” to combine both images into one final image. I could now sharpen and save it as a 
large image.  Then for the EID competition I could duplicate the image, title it, categorize it, and size it to a horizontal 1024 pixel wide 
image and it will be ready to submit for the meeting. 

Before and After  -  Ray Klein 

After 
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Field Trip Fun 

Sandy and Tim at LaPush Beach Sandy Tim and Racket LaPush Beach 

James, Tim and Rick in Hoh River Rain forest Rick Photographing toward Mt Olympus 

James at LaPush Beach 

Backlit Moss Tim Morton 

Photographs by James and Sandy Watt & Tim 
Morton.  Thanks to you all. 
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Field Trip Fun  -  Contd. 

Hoh River Valley—Tim Morton Olympic Mountains from Hoh River—Tim Morton 

Tim and Sandy in Hoh Rain forest 

Herd of Elk crossing in front of Rick 
leaving Hoh Rain forest 

Rick Setting up at LaPush Beach 

Tim photographing toward Mt. Olympus 
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Books From Abe Books 

Abe Books may be one of the easiest and best sources for all books photographic. 
 
 

Cntrl. Click Abe Books link above to search the site. 
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Judge’s Corner 
Judging Chair: Mark Shugert  shugertmark@gmail.com 

See how many of the red words in the analysis match up with the elements and which ones.  Which  important elements are missing? 
Notice how the analyst uses alternative words such as engaging instead of impact, and tight crop instead of composition.  This helps remove 

the monotony of the analysis. 

Judges For January: 
01/03 (Prints)  J. Fishback, R. Klein, R.Batson 

01/09 (King City) R. Klein, T. Morton, ? 

8 
Score 

The Analysis 
I find this to be a very engaging animal portrait. In my opinion the eye contact of the adult with the camera creates a 
very good area of interest. To my eye the colour reproduction of the fur is top class. I think the composition and the 
tight crop work very well. 
 
I think that the foreground of the image especially the paw of the younger animal is not sharp and catches my eye. 

James Mahon 
Analysis student 

The Elements 

Technical Excellence 
Composition 

Lighting 
Color 

Impact 
Creativity 

Presentation 
Story 

mailto:shugertmark@gmail.com
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Cool Stuff—PhotoJoJo 

  Have you ever tried making a smooth panning time-lapse video? Did you 
try holding your camera with superhuman steadiness or maybe even 
bribing a turtle with a fancy artisanal salad? 
  We've got an alternative for everyone who's out of arugula: presenting 
the Camalapse, a simple rotating stand for your phone or camera 
that helps you take pro-quality 360° timelapse videos.  
  The Camalapse's intuitive design makes it easy to use. Simply attach your 
camera (up to 5lbs!) or your camera phone (be sure to pick up a Camalapse 
Mobile), then point your lens where you want it to end up, twist, and 
start your cam. It rotates 90° in fifteen minutes, so it'll do a full 360° in 
an hour with no batteries required. 
 
$29 PhotoJoJo 

  Cameras: they're awesome, they make our 
lives complete, and they're super delicious. 
Wait ... what? 
  You heard us. Meet The Camera Cookie 
Cutter Set! These fun little molds make 
edible cameras! You get three different 
designs: an SLR, a classic rangefinder, 
and an old-school twin reflex camera . 
The set also comes with a dough stamp, 
perfect for stenciling out camera details 
with frosting and sprinkles (take that, Ace of 
Cakes). 
  You'll even get a fool-proof cookie recipe 
that even the most culinary-challenged 
shutterbug can follow! 
  Just whip up a batch of sugary shutter 
treats, and you'll be the coolest kid at the 
camera club -- that's pretty sweet! 
 
$18 PhotoJoJo 

  What likes Bananas and helping you take great photos? Yes, a helper monkey, 
AND also the Mini Magnetic Gorillapod. 
  This gem is tiny enough for pocket-carryin' and mighty enough for steady 
shots, shake free videos and group photos of the whole darn group. 
Its magnetic feet hold tight to any metal surface (hello street signs, fence posts 
and metal plates in heads). All while its bendy legs strike yoga-like poses to 
hold your phone in the perfect position. 
  Grab this li'l guy and any camera you've got with a standard tripod mount, 
for long exposures with no shake. Make use of that self timer for great self 
portraits. Grip your bike's handlebars for GoPro-in' like a real-live pro. 
  No batteries necessary. Stock up on bananas now, tho. 
 
$15 PhotoJoJo 
 
 
PS: 
We have seen this before, but I don’t think, with the magnet feet. 
Coooooooool!! 
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Fun With PSA  - Editor 



  Adapter                  Film Pack Camera Club - FPCC        18 

 

Fun With PSA  - Editor 

The story behind Joseph Rosenthal's Pulitzer Prize winning photograph, “Flag Raising on Iwo Jima” that is in the PSA collection is 
part of photographic history. On February 19, 1945, the Allies invaded the island of Iwo Jima, over six hundred miles off the coast of 
Japan, hoping to establish a staging area for bombers. Joseph Rosenthal, working for the Associated Press, landed amidst gunfire three 
hours after the invasion began. On the morning of February 23rd, Marines fought their way to the top of Mount Suribachi, raising the 
first of two American flags at 10:20am. Rosenthal and two other photographers were making their way up the mountain when the first 
flag was raised. By the time they reached the summit at 1:00pm, six soldiers were preparing to raise a second, larger flag. Rosenthal 
relates that he set down his bulky 4”x5” Speed Graphic in order to pile rocks and a sandbag to climb for a better view and almost 
missed the actual raising. “I thought of trying to get a shot of the two flags, one coming down, and the other going up, but I couldn't 
line it up, so I backed off about 35 feet. I decided on a lens setting between f-8 and f-11 and set the speed at 1-400th of a second. Out 
of the corner of my eye, I saw the men start the flag up. I swung my camera up and shot the scene. When you take a picture like that, 
you don't come away saying you got a great shot, you just don't know.“ 
Contrary to a later rumor that he had staged the photograph, is filmed evidence of the raising made by Rosenthal's colleague Bill 

Genaust, a Marine photographer standing shoulder to shoulder to Rosenthal, recording the scene. Sending his film to Guam for 
development, Rosenthal never anticipated that AP photo editor John Bodkin would consider the resulting image, “one for all time” and 
radiophoto it to New York for mass distribution only seventeen and a half hours after it was made. The full composition was 
horizontal showing more of the landscape surrounding the soldiers and the flag, but it was cropped for greater emphasis on the 
soldiers. In an article that appeared in Colliers magazine recognizing the tenth anniversary of the flag raising, Rosenthal describing his 
composition said, “The sky was overcast, but just enough sunlight fell from almost directly overhead because it happened to be about 
noon, that it gave the figures a sculptural depth. The wind whipped the flag out over the heads of the group, and at their feet, the 
disrupted terrain and the broken stalks of the shrubbery exemplified the turbulence of war.” 
It has been estimated that Rosenthal's classic war-time photograph may be the most widely reproduced photograph in American 

history. At the request of President Franklin D. Roosevelt It was printed on 3.5 million Treasury Department posters to publicize the 
7th war-bond campaign. The photograph has been used on two U.S stamps and replicated as a commemorative statue at the Marine 
Corps War Memorial in Arlington, Virginia. The story of the men in the photograph who came from diverse American backgrounds 
influenced three major motion pictures: “Sands of Iwo Jima” (1949), “The Outsider” (1962) and, “Flags of Our Fathers” (2006) all 
portraying an exact reenactment of Rosenthal's photograph. Only three of the six soldiers who raised the flag survived the battle on 
Mount Suribachi. Photographer Bill Genaust was also killed in the conflict. 
Following the war, ‘Joe' Rosenthal became a staff photographer and later photo editor for The San Francisco Chronicle where he 

remained until his retirement in 1981.  He died in Novato, California in 2006 at the age of 94. There is no record of who donated, “Flag 
Raising on Iwo Jima” to the PSA. It is an unsigned, 20”x16” sepia toned silver gelatin print believed to have been made from the 
original negative.  

Fun With PSA  - Editor 

Historic Prints of the PSA Print 
Collection: 
Flag Raising on Iwo Jima  1945 by Joseph Rosenthal  
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ACROSS 
1. Brand name of photo processing app 
or maybe just a brick (5) 
4. Kind of motion used to check sports 
games (3) 
7. You might need this battery for some 
of your gear (3) 
8. What some club members send in 
each month (acronym) (3) 
9. Do not let the judges do this to you 
when your print is up there (3) 
10. The photos that this person looks at 
would not be in competition (acronym)
(3) 
12. Old photos tend to do this, over and 
over (5) 
15. Last name of photographic legend 
(5) 
18. Canon uses this nomenclature for 
some cameras (3) 
20. One more than the top score in our 
competition (3) 
21. Australian colloquialism for a lout 
(3) 
22. Voiced by a public crier to gain attention (Var) (3) 
23. A small gull or maybe a kitty noise (3) 
24. A very popular camera brand (5) 
 

 

Crossword by James Watt 

DOWN 
1. Sometimes heard when great shots come up (4) 
2. You can put two in this category (4) 
3. Photo data from your camera (4) 
4. Many comments are ____ during judging (4) 
5. You might get some great street shots in this Texas town (6) 
6. Fall would be a good time to photograph these (4) 
11. You might want to remove this, especially from portraits (6) 
13. Useful lens feature (acronym) (2) 
14. There might be a switch on your lens labeled this (acronym) (2) 
15. Basic building block of matter (4) 
16. You may have to start ___ when you get lost in processing (4) 
17. To get your pics, you need to ____ your camera to your PC (4) 
18. Very poetic color for a background, maybe (4) 
19. You could try this to get an old print to digital. (4) 

      M 

      O 
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E       

R       
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PSA Rep.: Jon Fishback  jpf1@aol.com 

4 C’s Rep.: John Craig  jc_craig06@comcast.net 

Great Photographers in History 
  October 28, 2016 /Photography News 

  Born 160 years ago today, on 28 October 1856, Mary 
Dorothea Frederica Steen was a Danish photographer and 
feminist. In 1884, at the age of 28, she opened a studio in 
Copenhagen where she specialized in indoor photography, 
a difficult art at a time when electricity was not widespread. 
The photographs she took at the Flerons' house on 
Copenhagen's Vesterbrogade are among the first showing 
people inside their own homes. She later became 
Denmark's first female court photographer, working not only 
with the Danish royals but with the British royal family too. 
Around 1895, Princess Alexandra invited her to London 
where she photographed members of the royal family, 
including Queen Victoria at Windsor Castle.  
  Mary Steen also played an important part in improving 
conditions for female workers and encouraging women to 
take up the profession of photography. In 1891, she was the 
first woman on the board of the Danish Photographers 
Association. She was also active in the Danish Women's 
Society (Dansk Kvindesamfund) where she sat on the board 
from 1889–1892. Together with Julie Laurberg, she 
photographed the leading figures in the Danish women's 
movement. In 1891, she received a grant from the 
Reiersenske Fond, a trade association, which allowed her to 
travel to Germany and Vienna. 
  She campaigned for better working conditions for women 
including eight days holiday and a half day off on Sundays. 
She treated her own staff well, paying good wages. Her 
example was widely followed. 
  As a result of growing deafness, she closed her studio in 
1918. She died on 7 April 1939. 

Queen Victoria and Princess Beatrice inside 
Windsor Castle  

Danish photographer Mary Steen 1895 

mailto:jpf1@aol.com
mailto:jc_craig06@comcast.net

